
 Personal Golf Tracker

Personal Golf Tracker (PGT) is a comprehensive program that lets you keep a close eye on your golf 
game.    It is distributed as Shareware.    If you use the program you should pay the registration fee.    You
receive significant benefits for registering.    See Benefits of registering for details.
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Working with Golfers
Adding golfers
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Working with Courses
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Working with Rounds
Adding rounds
Modifying rounds
Deleting rounds
Adding notes to rounds
Adding statistics to rounds
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Converting Files From the DOS Based Version of PGT
Registered users of PGT for Windows receive a conversion program that will enable all golfer files used 
by the DOS version of PGT to be used in Personal Golf Tracker for Windows.    Information such as 
statistics names, rounds, courses, and golfers that have been entered into the DOS version will be 
converted.



Adding Rounds
You can add rounds to PGT by clicking New under the Rounds menu or by entering Control+R from the 
keyboard.    In order to add a round you must first select both a course and a golfer. See Adding golfers 
and Adding courses for more information.    When you do this, the Add Rounds window will open.    There
are limits to the number of rounds that can be added to PGT. See Database limits for more information.

When you enter individual hole scores the cursor will advance to the next hole depending on the setting 
of the Nine or Better check box.    If you have individual hole scores over nine you will have to clear the 
check box to enter the score. To back up a hole hold down the shift key and press tab.

You can keep the rounds window open by clicking Add and entering another round.    Click OK when you
are finished adding rounds.    Rounds that you add are assigned to the Selected golfer and Selected 
course.

You can attach notes to a round by clicking on Notes and you can add special statistics of your choosing
by clicking on Stats



Adding Notes to Rounds
When you are adding or modifying a round you can attach a note by clicking Notes on the Add/Modify 
Rounds window.    You can enter up to 192 characters in a note.

You may want to keep track of the type of day it was, who you played with - anything special.    You can 
view the note later by clicking View notes under the Rounds menu. See Viewing notes for more 
information.



Modifying Rounds
To modify a round, click on one of the rounds listed on the main screen.    After you do that you will be 
able to select Modify on the rounds menu.    You can also enter Control+M from the keyboard after 
highlighting a round. Modifying a round is much the same as entering a new round.    See Adding rounds
for more help.



Deleting Rounds
The best way to delete a round is to press the delete key after highlighting a round on the main screen.   
Another way is to click on Delete under the Rounds menu.    You can also enter Control+D from the 
keyboard or press the Del key when a round is highlighted. If a round is highlighted the Rounds Delete 
window will locate the round for you.    You can delete the highlighted round by clicking on the Delete 
button or you can delete the round by dragging the round to the trash can.



Dragging is depressing and holding down the left mouse button and moving to a destination and 
releasing the button.



Deleting by Dragging
To delete a round by dragging, depress the left mouse button and drag the golf cart icon to the trash can
and release the left button.



Deleting Courses
The best way to delete a course is to press the delete key after highlighting the course on the main 
screen.    Another way is to click on Delete under the Course menu.    If a course is highlighted, the 
Course Delete window will locate the course for you. Alternatively, you can press the Del key when a 
round is highlighted.    After the delete window opens, you can delete the highlighted course by clicking 
on the Delete button or you can drag the course to the trash can.



Viewing Notes
If a round on the main screen has an "n" to the right of the date you can highlight the round and click 
View notes under the Rounds menu to read the note.    You can also enter Control+V from the keyboard. 
If you cannot select View rounds from the Rounds menu you have either not highlighted a round or the 
round you have highlighted does not contain a note. 

Another way to view notes is to double click on the round, course, or golfer whose note you want to 
view.



Adding Statistics to Rounds
When you are adding or modifying a round, you can attach up to six statistics to track.    You can assign 
your own names.    The range for statistics entries are integers from 1 to 999.    PGT will double your 
statistics when entering nine hole rounds if you have checked the "Double stats for nines" check box 
when entering a round.    Doubling stats keeps nine and eighteen hole rounds synchronized by doubling 
statistics for nine hole rounds when you view the statistics graphs.    This helps you get a more realistic 
measure of your progress.

Rounds that have statistics attached to them have an 's' next to the date on the main display window.    
You can change the statistics by clicking Modify under the Rounds menu.



Understanding Graphs
See the following topics for an explanation of graphs available with PGT:

Consistency
Distribution Graph
Statistics Graph
Detailed Statistics Graph



Statistics Names
Choose Name statistics under the Statistics menu.    Doing this enables you to name the statistics you 
want to track.    Use you imagination.    For instance, if you have a particular statistic that you want to 
track, you could put a name on it such as "ThreePutt".

Note: Once you assign a statistic name and assign rounds to it, changing the name may confuse you 
because all rounds are assigned the statistic name you have selected to use. Therefore, your 
statistics names should be meaningful and consistent throughout the program.



Adding New Courses
You can add courses up to the Database limits.    When you add a course, remember that PGT accepts 
course pars of three, four, and five.    When you add a course, the course name must be unique without 
regard to capitalization.    For example, "Swan Lake" is the same course as "swan Lake".    PGT will still 
display the name as you typed it.

If you want to change the course name later, you must delete the course and reenter it.    Furthermore, 
any rounds attached to the old course name will not be displayed or used in calculations unless the 
names are an exact match.    See Database linkages for more information. Therefore, be sure you 
properly name a course before adding it to the database.

PGT uses your entry of the course rating when calculating handicaps for eighteen hole rounds.    If you 
don't enter a rating or the rating you enter is outside reasonable limits, PGT uses course par to figure 
Handicaps.    Slope is used for reference only.    It is not used for handicap calculations. See Handicap 
calculations for more detail.



Database Linkages
PGT assigns the Selected course and Selected golfer to each round entered by the name you assign.    
Therefore, course names and golfer names must match the names assigned to rounds.    This does not 
present a problem unless you change a course name, or delete a course from the database.    If you do 
this, rounds previously assigned will not match a course and PGT will not use those rounds in listings or 
calculations.

If you accidentally delete a course and want to reinstate it, just add the course back into the database.    
Be sure the course name you assign is exactly the same as the course name assigned previously.    You 
can list all the courses assigned to rounds in the Delete Rounds window.



Modifying Courses
To modify a course, click on one of the courses you want to modify.    This will highlight the course.    You 
can click on the Course icon on the Tool bar to list the courses.    After highlighting the course, click on 
the Course menu and on Modify to open the Course Modify window. Changing entries is much like 
Adding Courses.

Because PGT matches course names with rounds, you can't change a course name.    See Database 
linkages for more information.



Adding Golfers
Click on File from the main menu then click New.    You can also type Control+G from the keyboard.    
This will display the Add Golfer window.    Enter a golfer name and a file name for the golfer you want to 
add.      Both golfer names and the file names you assign must be unique.    Your golfer name may be any
character up to a total of twenty characters.    The file name can be up to eight letters or numbers.    PGT 
will append the file name extension of .GLW. To close the Add golfer window, click on Cancel. See 
Database linkages for more help.



Deleting a Golfer
To delete a golfer, press the delete key after listing the golfers and highlighting the golfer you want to 
delete.    PGT will open the Delete Golfer window and select the golfer for you. If you wish, you can go to
the Delete Golfer window by clicking on Delete under the File menu.    Doing this will open the Delete 
Golfer window. Click on the golfer name you want to delete and click Delete.    You can also delete a 
golfer by dragging to the trash can.



Date Filter
Personal Golf Tracker does calculations only for rounds that are between two dates.    The Oldest and 
Newest dates are displayed in the lower left section of the screen. Click on the dates to change them.

This feature enables you to exclude certain rounds from the calculations PGT makes.    Although all 
rounds are listed, only those with an asterisk (*) next to the round's date are used in graphs, summaries,
and all calculations.

Note: If the dates are set in a way you don't intend, you can be mislead regarding your performance.



Database Limits
The default number of golfers, courses, and rounds is 100.    These limits can be changed by modifying 
the WINPGT.INI file included with Personal Golf Tracker. See Modifying WINPGT.INI for more 
information.

Because all rounds are kept in memory to increase speed, you may want to reduce the number of 
rounds per golfer to conserve memory.

Note: If you set the limits in WINPGT.INI to values less than your highest number of rounds, golfers, or 
courses in the database, PGT will generate an error and the program will terminate. This is done to keep
the database intact. Keep this in mind if you change the settings.



Modifying WINPGT.INI
You can modify the settings in WINPGT.INI if you wish.    You will find the file in your Windows directory.   
To make the changes, use an ASCII text editor such as the Notepad application that ships with 
Windows.

Be careful modifying WINPGT.INI.    If you decrease the settings and have more golfers, courses, or 
rounds entered than the number you assign in the file, PGT will terminate.

If you need to enter more rounds, courses, or golfers than the default limits, keep in mind that there is a 
tradeoff in memory usage because all rounds, courses, and golfers are stored in memory when the 
program is running.    This is done to increase speed.



Golfer Files Directory
You can select a directory of your choosing for storing rounds. Click on New golfer under the Files menu 
to assign a directory for golfer storage. When you add a golfer to the database it is assigned to the 
directory shown in the directory list.    To see where a golfer file is stored, double click on the golfer's 
name in the Golfer Name List Box. Doing that will change the directory to the one that is assigned to the 
golfer you selected.

Note: It is a good idea to pick a directory for all golfers and use it consistently. If you delete a golfer's 
file, all rounds entered for that golfer will be lost.



Backing Up Your Database
As with all things mechanical you will, at some point, have a problem with your hard disk. It would be a 
good idea to keep a backup up all golfer files on floppy disk.    The important files are:

File contents: Description:

Rounds Storage: Any file with a file name extension of <filename>.GLW.    These files are where 
the rounds for each golfer are located.

.
Course Storage: COURSEW.LST. This file stores all information about the golf courses entered in 

the Personal Golf Tracker database.

Golfer Storage: GOLFERW.LST. This file keeps track of the location of the golfers' files, 
summaries, and calculations.

Program Defaults: WINPGT.CNF. This file contains important information the program needs to 
operate properly along with statistics names, sort order selections, and other 
data.

Program Limits: WINPGT.INI. This file contains the Database limits. The maximum number of 
rounds, courses, and golfers are stored there along with the start-up window size.

Note: Your course storage, golfer golfer, and program defaults files are located in the directory in which 
you installed PGT. The rounds storage files are located in the directory you assigned them to when 
adding golfers. The program limits file is in the Windows directory.



Printing Reports
You have many options available to you when printing. You can select any one, or all of the reports by 
checking the boxes. To change the appearance of your printout, see Using Different Fonts when Printing 
Below is a listing of the names for the check boxes and a description of the report each option will 
produce:

Rounds: Checking this box causes PGT to list the rounds on a hole by hole basis for the Selected 
golfer on the Selected course. Your printout will include a listing of each round played. It is 
important to note the round number listed before the date. Other information you print, such 
as statistics and notes, also designate the round number. That way you can associate the 
information you entered with each report.

Statistics: Checking this box causes PGT to printout the statistics that you have chosen to keep track of.
Using this option, you will get both a round by round listing of statistics along with summaries 
which include the Total, Average, Highest, Lowest, and Average Deviation.

Notes: To printout the notes you have assigned to rounds, select the Notes check box. You will get a 
printout of the notes as you entered them. You associate a note with a round by matching the 
note number with the round number which is listed with the rounds and statistics listing.

Graphs: You can printout three graphs by checking this box. The three graphs are:

The Consistency graph    includes only the rounds for the current course and the current
golfer. Note: This graph is valid only for the selected course and the selected golfer. Since
par on one course varies on a hole by hole basis with another course, including more 
than one course would invalidate the information. See Consistency Graph for more 
information 

The Distribution graph includes distribution statistics for the selected golfer on all 
courses. If the Selected only option button is active, the distribution graph will include only
the scores for the selected course. Note: The Distribution graph on the computer display 
can only show rounds for the selected course. See Distribution Graph for more 
information.

The Statistics graph includes the last twenty statistics for the selected golfer on all 
courses. If the Selected only option button is selected, the Statistics graph will include 
only the scores for the selected course. Note: As with the Distribution graph above, the 
Statistics graph on the computer display can only show rounds for the selected course. 
See Statistics Graph for more information.

Option button settings

The Option buttons control what is included in the printouts. For example: If you are a league secretary, 
you may want to printout certain statistics for all golfers in the league. If you are an individual keeping 
track of your rounds but play several courses, you may want a printout that spans across all courses.    Or,
you may want information for just yourself on a single course. 

Selected Only: Rounds print out only for the selected golfer and the selected course. Also, selecting 
this option causes the Distribution and Statistics graphs to print only information for the 
selected course. If this option is not selected, the graphs mentioned above will include 
statistics which include all courses.

All Golfers: The rounds printout will include the rounds for all golfers in the database that have 



rounds on the selected course.

All Courses: The rounds printout will include rounds for all courses in the database that have rounds
for the selected golfer.

Other Printing Options:

Course Listing: Printout a listing of all the courses in the database by checking this box. You will 
print hole by hole par for each course along with the course rating and slope.

Course Rankings: Check this box to printout a sorted ranking of your performance on a course by 
course basis. If you are running a league which has many golfers that play on 
many courses, you will have to select each golfer separately and reprint this report.
The printout will be sorted based on your selection on the "Sort courses by" setting 
under the Course menu.

Golfer Rankings: You can printout the summary for each golfer for which you have entered rounds. 
PGT will include all courses in the calculations. This is the most useful printout for 
leagues. Total points you have assigned when entering rounds is shown. The 
printout will be sorted based on your selection on the "Sort golfers by" setting under
the File menu.

Stat Names Sheet: To printout a sheet that has a listing of the statistics names you have entered, 
check this box. You will get a sheet of names that you can take to the course with 
you to help you keep track as you play.



Benefits of Registration
Personal Golf Tracker is distributed under the Shareware concept.    As such, you are encouraged to 
copy and share this version of PGT with others.    If you use the program you should register your copy.   
Aside from encouraging the author to continue to update the program, you receive significant benefits 
for registering:

You get the latest version of PGT.

You receive a printed and illustrated manual.

You get copies of golfing icons.

After hours phone support will be provided.

You get notification and discounts on future versions.

You will be supporting the Shareware method of software distribution which enabled you to try out
PGT before buying it.

The author is a member of the Association of Shareware Professionals. This assures you that 
you are doing business with an author dedicated to the advancement of Shareware and customer 
satisfaction.

Thank you in advance for registering your copy of PGT.

Please register your copy by sending $25.00 US to:

John L. Hancock
2713 Trelawny Dr.
Clarksville, TN    37043

Overseas registrations: Please add $3.00 shipping and handling.



Association of Shareware Professionals (ASP)
The ASP is a organization devoted to advancing the concept of Shareware as a marketing alternative to 
commercial software distribution.    Members of the ASP must reach detailed standards of excellence 
and maintain certain guidelines established by the ASP.    The ASP has an Ombudsman to help settle 
any dispute between an ASP member and his registered customer should that become necessary.    See
ASP Ombudsman for more information. In general, when you register your product with an ASP 
member you are dealing with a person or company that is dedicated to the advancement of Shareware 
and subscribes to the principals laid down by the organization.



Displaying Summaries

Click on the Summation button to cause PGT to calculate the percentages, deviations, best 
round, handicaps, and averages displayed at the bottom of the screen.    Keep in mind that all calculations
and graphs are filtered by the Oldest and Newest dates in the lower left portion of the screen.

For details on the mathematics used to make the calculations, see the topics below:

Rounds averages
Average deviation
Best round
Percentages
Handicaps
Hole by hole percentages



Deviation Calculation
Deviation is an average deviation off all scores that fall within the Oldest and Newest dates.    PGT 
calculates the average of all rounds, sums the absolute value of the difference between the average and
the scores, then averages the differences.    The lower the number the more consistent you are.



Handicap calculation
By default, PGT uses the best ten of the last twenty rounds to calculate eighteen hole handicaps.    The 
program will not figure a handicap until five rounds have been entered.    In order to make PGT valuable 
for nine hole leagues, the default selection offers three nine hole rounds being required to establish a 
nine hole handicap.    PGT uses the best nine of the last eighteen nine hole rounds to figure a nine hole 
handicap.

If the Course rating was entered when a course was added to the database, PGT will use it to calculate 
eighteen hole handicaps.    If not, PGT uses course par.    In the case of nine hole rounds, PGT uses 
course par to develop handicap differentials.

You can change the basis used for calculating handicaps. To change the PGT defaults, click on Rounds 
and Custom handicaps. Enter the values you prefer and save each set of parameters by clicking the 
Save button.

Note: You must click the Save button for each set of handicap parameters you change. Said another 
way, you must click the Save button three times if you have changed all three sets of parameters.

PGT chooses how many rounds to include in calculations based on the schedule below. This example 
uses the default values supplied by PGT (best 10 of the last 20 starting with five rounds) for eighteen 
hole handicap calculations. If you use numbers of your own, the table adjusts to accommodate your 
selection. Keep in mind that handicap calculations include only rounds that fall with the Oldest and 
Newest dates assigned in the lower left corner of the main screen.

Rounds entered Best used 
1-4 0
5-6 1
7-8 2

9-10 3
11-12 4
13-14 5
15-16 6

17 7
18 8
19 9
20 10

IMPORTANT:    Handicaps calculated by PGT are not official. Therefore, you should not use PGT to 
establish handicaps for competitive events.    Handicaps figured by PGT are for your information only 
and are not intended for you to use when comparing yourself to other golfers.    They are included to give
you a measure of your individual progress.



Average Calculation
Averages are calculated for all nine hole rounds and all eighteen hole rounds that fall between the 
Oldest and Newest dates. The front and back nines are figured separately. Eighteen hole averages are 
figured on eighteen hole rounds only.    Therefore, the sum of the front and back nine averages may not 
equal the eighteen hole average.    Averages shown at the bottom of the main screen are calculated for 
the Selected course only and are filtered by the Oldest and Newest date. 

To see averages including all courses, list the golfers by clicking File and List Golfers on the main menu.



Percentage Calculation
Depending on the setting of the Options menu, PGT lists, on the Percentage line, the percent of the time
your hole score reached the goal.    For example, if Bogey is selected on the Options menu and a 
percentage number equals 66 then your scores for that hole have been Bogey or better 66% of the time.
If your percentage reaches 100% then PGT prints two dashes for that hole. The percentage is calculated
against the Selected course and filtered by the Oldest and Newest dates.



Best Round Calculation
Depending on your selection on the "Best score by.." setting under the Options menu, you can show 
your best score on a hole by hole basis or on a nine hole basis. Your best score on the selected course 
is shown along the bottom of the window. If you have selected "Best score by holes" from the menu, 
PGT keeps track of the best hole score as you add rounds.    This is intended to show what you are 
capable of if you were to shoot your very best. Some people prefer to call this calculation "Fantasy 
Best". If you checked "Best score by nines" on the menu, PGT displays your best front and back nine 
entered for the Selected Course.



Using the Tool Bar

The tool bar consists of the buttons along the upper right of the main screen display. Click on the button 
above to see a description of the item's action.

Summarizing rounds
Adding golfers, courses, and rounds
Listing rounds
Listing statistics
Listing courses
Listing golfer rankings
Graphing your consistency
Graphing your score distribution
Graphing your statistics



Hole by Hole Comparisons to Par, Bogey, and Double Bogey
Most golfers compare their scores referencing Par, Bogey, or Double Bogey. There is one calculation 
affected by the Par, Bogey, or Double Bogey selection on the Options menu: The Percentage line at the 
bottom of the screen changes to represent the percentage of the time your hole score was equal to or 
better than the option you selected.    When you select one of these options, the summary portion of the 
screen will clear. For more information see Notification of the Need to Summarize the Rounds



Using the Tool Bar to Add Golfers, Courses, and Rounds

Click on this button to add a round. If the button is dimmed, you have entered rounds up to the 
current limit of the database. To learn how to change the database limits, see Modifying WINPGT.INI.

Click on this button to add a course. As with the Add Rounds button, if the button is dimmed, you 
have entered courses up to the current limit of the database.

Click on this button to add a round:



Listing Entered Rounds

As long as there are rounds entered for the Selected golfer and the Selected course, you can list 
the rounds assigned by clicking this button. 

You can also list rounds by opening the Rounds menu and clicking List. Alternatively, you can enter 
Control+L from the keyboard.

Note: If the button is dimmed, there are no rounds entered for the Selected golfer and the Selected 
Course.



Listing Statistics on Entered Rounds

If there are statistics entered for the rounds assigned to the Selected golfer and the Selected 
course, you can click this button to list the statistics along with a summary of performance.

You can also list statistics by clicking on List under the Statistics menu.

Note: If the button is dimmed, there are no statistics entered for the Selected golfer and the Selected 
Course.



Listing Entered Courses

If you have entered courses into the PGT database, you can display them by clicking on this 
button. You will see a listing of the course par for each hole, the nine and eighteen hole totals, course 
rating, and Slope.

You can also list courses by clicking on List under the Course menu.

Note: If the button is dimmed, there are no courses entered into the PGT database.



Listing Golfer Rankings

If you click on the Golfer button, PGT will display a listing of all golfers in the database. Displayed 
will be the average or differential score on nine and eighteen hole rounds for each golfer. You decide to 
display averages or differentials under the Options menu. Averages on par 3's, par 4's, and par 5's are 
displayed along with handicaps with the first few letters of the titles you have selected under the Custom 
Handicaps window found under the Rounds menu.

You can also list golfers by clicking List under the File menu.

Note: If the button is dimmed, there are no rounds entered into the PGT database.



The Consistency Graph

The Consistency graph is displayed by clicking on Consistency under the Graphs menu. You can 
also click on the left hand graph button on the Tool bar.This graph displays your highest and lowest 
scores you have entered on the Selected course.    The highlighted area indicates your average score on 
each hole. This graph can help you get an idea of your consistency on a hole by hole basis.    As with all 
other PGT calculations, the information is filtered by the Oldest and Newest dates.

Calculations are made based on the Selected course. This helps you see how you are doing on 
any particular hole on a particular course.



The Statistics Graph

This graph is displayed by clicking on Statistics under the Graphs menu.    You can also click on 
the right hand graph button on the Tool bar.    This graph displays six graphs of the statistics you are 
tracking.    The graph shows the most recent twenty rounds entered.    To see more rounds, open the 
Statistics menu and click on the Statistic name you want to see.    As with all other PGT calculations, the 
information is filtered by the Oldest and Newest dates.



The Distribution Graph

This graph is displayed by clicking on Distribution under the Graphs menu.    You can also click on
the middle graph button on the Tool bar.    This graph displays your count and percentage distribution of 
birdies, pars, bogeys, etc. for the Selected course. As with all other PGT calculations, information is 
filtered by the Oldest and Newest dates.



The Detailed Statistics Graph
Open the Statistics menu and click any statistic name on which you want to view a graph.    The window 
will display the last 100 rounds.    The graph is automatically scaled and is a good indicator of your 
improvement for the statistic you are tracking.    If you want to see all statistics graphs together see The 
Statistics Graph.    As with all other PGT calculations, information is filtered by the Oldest and Newest 
dates.



Definition of Shareware
Shareware distribution gives you a chance to try software before buying it. If you try a Shareware 
program and continue using it, you are expected to register. Individual programs differ on details -- some
request registration while others require it, some specify a maximum trial period. With registration, you 
get anything from the simple right to continue using the software to an updated program with printed 
manual.

Copyright laws apply to both Shareware and commercial software, and the copyright holder retains all 
rights, with a few specific exceptions as stated below. Shareware authors are accomplished 
programmers, just like commercial authors, and the programs are of comparable quality. (In both cases, 
there are good programs and bad ones!) The main difference is in the method of distribution. The author
specifically grants the right to copy and distribute the software, either to all and sundry or to a specific 
group. For example, some authors require written permission before a commercial disk vendor may 
copy their Shareware.

Shareware is a distribution method, not a type of software. You should find software that suits your 
needs and pocketbook, whether it's commercial or Shareware. The Shareware system makes fitting 
your needs easier, because you can try before you buy. And because the overhead is low, prices are low
also. Shareware has the ultimate money-back guarantee -- if you don't use the product, you don't pay for
it.



Warranty and Disclaimer
Personal Golf Tracker is a copyrighted program.    By accepting and using this software, you 
acknowledge that it may not suit your particular requirements or be completely trouble free.    Properly 
applied this program should operate without error.    However, I am not    liable for your specific 
application or problems resulting from its use.    If the Personal Golf Tracker software does not perform 
as described liability is limited to replacement of the program and refunding the purchase price to 
registered users only.    There is no liability to you or any other person or entity for any damage or loss, 
including special, incidental, or consequential damages, caused by this software, directly or indirectly.    
Some states do not allow the limitation or exclusion of liability for incidental or consequential damages, 
so the above limitation or exclusion may not apply to you.    This license agreement is governed by 
Tennessee law.    If any part of this agreement is found to be held invalid, the remainder will remain in 
effect.    This agreement may only be modified by the written consent of the author.



Using the menus

Click on the menu item above for information about using each menu item, or click on the topic 
below.

File Menu
Edit Menu
Course Menu
Rounds Menu
Graphs Menu
Statistics Menu
Options Menu
Help Menu



File Menu
New Golfer... Select this menu item to add a golfer to the database.    Enter a golfer file name 

and a golfer name and click OK. After entering golfers, press Cancel to continue.
You can find more detail under Adding Golfers.

Delete Golfer... Use this menu selection to delete a single golfer or several golfers. Highlight the 
golfer you want to delete and drag it to the trash can, or press Delete. See 
Deleting a golfer for more information.

List Golfers You can list all golfers in the PGT database by selecting List golfer from the 
menu.    To view a golfer's notes double click on the golfer. To select a golfer to 
delete press the Delete key after highlighting a golfer.

Sort Golfers by > You can sort the golfers based on twelve different criteria. Check the way you 
want to sort them by clicking on this menu item, then select the sort criteria on 
the sub menu. After selecting the sort order, list the golfers by clicking on List 
Golfer under the File menu.

View Golfer's Notes Highlight the golfer on which you want to read a note and click on this menu 
item.

Print... Open the print dialog box and select the print criteria. For more information on 
printing see Printing reports.

Print Font Setup Select this item to format the look of your printout. For more information on 
formating your printed reports see Print Font Setup.

Exit Save the configuration file and exit Personal Golf Tracker.



Edit Menu
Copy Click on Copy under the Edit menu to save the listing of golfers, courses, 

rounds, or statistics to the Windows clipboard. You can also press 
Control+Insert from the keyboard to copy the data to the clipboard.

When you click Copy while displaying a graph, a bitmap of the graph will be 
stored on the Clipboard which can be pasted into a graphics application such as
Windows Paintbrush.



Course Menu
New... Select this menu item to add a course to the database.    Enter course par for 

each hole, a course name, rating, slope, and notes and click OK. When finished 
entering courses, click Cancel to continue. You can find more detail under 
Adding Courses.

List List the courses in the PGT database by clicking on list.

List course averages Selecting this menu item causes PGT to calculate summaries for each course 
for the Selected golfer listing the courses, averages or differentials, averages on
par 3's, 4's and 5's, and average deviations. Calculations for rounds are made 
based on the setting "Rank by..." under the Options menu.

Sort averages by > You can sort the averages based on ten different criteria. Check the way you 
want to sort them by clicking on this menu item. Then, select the sort criteria on 
the sub menu. After selecting the sort order, list the courses by clicking on List 
under the Course menu.

Modify... Click on Modify to modify a course that has already been entered. You can 
modify any element you wish except the course name. See Modifying 
Courses for more information. For information on why a course name cannot be
changed, see Database linkages.

View Notes Highlight the course on which you want to read a note and click on this menu 
item.

Delete... Use this menu selection to delete a single course or several courses. Highlight 
the course you want to delete and drag it to the trash can or press Delete. See 
Deleting a Course for more information.



Rounds Menu
New... Click New to add a round to the database. If the selection is dimmed you have 

entered the maximum number of rounds. To change the maximum number of 
rounds, see Modifying WINPGT.INI.

List List the rounds in the PGT database by clicking on List. More data is available 
about listing rounds. If a "s" appears after the date see Adding Statistics. If an 
"n" appears after the date see Viewing Notes. To find the meaning of an "*" 
after the date see Date Filter.

Summarize To cause PGT to calculate the percentages, averages, handicaps, etc. on the 
lower portion of the screen, select this menu item. 

Modify... Click on Modify to modify a round that has already been entered. You can 
modify any element you wish. You must first highlight a round before this menu 
selection becomes active. See Modifying Rounds for more information.

View Notes Highlight the round on which you want to read a note and click on this menu 
item. Items marked with an "n" after the date indicate that a note has been 
added to the round.

Custom Handicaps... Personal Golf Tracker gives you several options that you can select and modify 
to customize handicap calculations. Click this item to open a dialog box to 
customize handicaps. For more information see Handicap calculations.

Delete... Use this menu selection to delete a single round or several rounds. Highlight the
round you want to delete and drag it to the trash can or press Delete. See 
Deleting a round for more information.



Graphs Menu
Consistency Also called a "Hilo" graph or "Bandaid" graph, it shows your hole by hole comparison 

to par, bogey, or double bogey depending on the setting on the Options menu. See 
Consistency graph for more information.

Distribution Displays the number and percentages of eagle, par, bogey, etc. of scores for the 
Selected golfer on the Selected course. See Distribution graph    for more 
information.

Statistics Displays "mini graphs" of the six statistics you have selected to track. You choose the
statistics names under the Statistics menu item. See the Statistics graph for 
more information.



Statistics Menu
Change Names... If you want to change the names that are provided as defaults by PGT, this is 

where you do it. You can enter any name you want. Additional details can be 
found in Statistics names. You can also enter Control+N from the keyboard to 
change names. Statistics names are "global". Therefore, the name you assign 
should apply to all courses. Assigning a name such as "PuttsOn#4" would be 
valid only for a single course. You would be misled if you use this name for 
statistics on a different course.

List Click List to display statistics entered for the Selected golfer on the Selected 
course. Total, highest, lowest, deviation, and average are displayed at the bottom
of the screen.

Detailed Statistics This menu selection enables you to "zoom" in on a graph of a single statistic that 
you are tracking. It gives more detail and includes more rounds, so it may be 
more meaningful to you than the six mini-graphs that can be shown by selecting 
Statistics on the Graphs menu



Options Menu
Par Checking Par causes the default percentage calculation to compare hole by 

hole performance to par on the lower portion of the screen.

Bogey Checking Bogey causes the default percentage calculation to compare hole 
by hole performance to Bogey.

Double Bogey Checking Double Bogey causes the default percentage calculation to 
compare hole by hole performance to Double Bogey.

Calculate as averages Click here to display all averages for front, back, and eighteen hole rounds 
as the average score for rounds entered. This does not become a problem 
until calculations are made that include more than one course. If you prefer 
to show average scores, be aware of how you can be misled. For example: 
If you play on courses that have pars lower than full regulation courses such
as par three courses, your averages will be misleading. In such cases, it is 
more accurate to show calculations based on differentials.

Calculate as differentials Click here to rank and display nine and eighteen hole calculations as 
differentials. Displaying results as differentials is a better measure of 
performance if the courses in the database have different pars. If par on the 
courses you play tend to be 70 to 72, you may want to calculate as 
averages.

Best score by nines There are two ways you can display the bottom line (BEST SCORE:) on the 
main screen: Checking "by Nines" on the menu causes PGT to show you 
the best front and back nine you have entered.

Best score by holes If you check "by Holes", PGT will show you the best score you have 
achieved on each hole. Some people call this "Fantasy Best".

Automatic Recalculation As shipped, PGT does not automatically recalculate summaries when a 
change is made that would cause summary data to become invalid. Instead,
when this occurs, PGT clears the bottom display area to indicate the need 
for recalculation. You can cause Personal Golf Tracker to automatically 
recalculate and display summaries after changes by checking this menu 
item.

Confirm Delete Checking this menu item causes PGT to confirm your decision when 
deleting courses, rounds, or golfers. This can help you confirm your wishes 
a second time. Keep in mind that when you delete a golfer, all rounds 
associated with that golfer are deleted from your hard disk and can no 
longer be accessed from within PGT.

Note:Remember that calculations are made for rounds that are within the Oldest and Newest dates 
assigned on the main screen.



Help Menu
Index... Displays the Personal Golf Tracker help file.

About PGT... Displays information about the PGT version number and serial number.

Print Registration Form Prints the Shareware registration form on the printer. You are encouraged to
register using this form to help the author improve the program.



Notification of the Need to Summarize the Rounds
Often you will notice that when you change something such as pressing a Tool bar button, adding or 
modifying rounds or courses, changing Custom handicaps, etc. causes the bottom (summary) section of
the screen to clear. The reason this occurs is because the action you have taken would cause the 
summary data to become invalid. When this happens, it is necessary to press the summarize button on 
the Tool bar to cause PGT to recalculate summaries based on the new parameters you have selected. 
The reason PGT behaves in this way is to increase the speed of response. You can, however, have PGT
automatically recalculate summaries. Check Automatic Recalculation under the Options menu to enable 
automatic recalculation. When you have entered many rounds into the database, you may not want 
automatic recalculation turned on because calculations can take some time to complete.

Note: If no rounds have been entered for the selected golfer on the selected course, the Summation 
button on the Tool bar will be dimmed.



Recalculation of Summaries and Handicaps
When listing Golfer rankings you will notice PGT recalculate handicaps and/or summaries from time to 
time. This occurs if you change anything that would invalidate the displayed data. For example: If you 
modify course par, all rounds attached to that course by all golfers in the database will have invalid data.
Personal Golf Tracker will automatically make the necessary recalculation and re-display the rankings. 
Because these calculations can take some time on large databases (many rounds and many golfers), 
PGT makes the recalculation when displaying rankings only. A meter is provided to help you keep track 
of the progress.



ASP Ombudsman
"This program is produced by a member of the Association of Shareware Professionals (ASP).    ASP 
wants to make sure that the Shareware principle works for you. If you are unable to resolve a 
Shareware-related problem with an ASP member by contacting the member directly, ASP may be able to
help. The ASP Ombudsman can help you resolve a dispute or problem with an ASP member, but does 
not provide technical support for members' products. Please write to the ASP Ombudsman at 545 
Grover Road, Muskegon, MI 49442- 9427 or send a Compuserve message via CompuServe Mail to 
ASP Ombudsman 70007,3536"    



Differentials
A Differential is the difference between your score and course par or rating. A score of 95 on a par 72 
course would result in a differential of 95-72 or 23.



Adding Notes to Golfers
Add notes to a golfer by first adding a golfer into the database. Select File New from the menu and enter 
the golfer name and the golfer file name. Having done that, click on the golfer name in the golfer name 
list box (lower right hand list box) to which you want to add a note. That will activate the Notes button. 
Click the Notes button and enter your note and click OK. You can enter up to 256 characters in a golfer 
note. To exit the New File dialog box click on Cancel.



Adding Notes to Courses
Add notes to a course by clicking on the Notes button on the Add/Modify Course dialog box. Enter your 
note and click OK. After other course information is entered, click on Add/Modify to add the course along 
with the note to the PGT database. Up to 256 characters are allowed in a course note.



Scope of Averages
Since many golfers want to see summaries of their performance in many different ways, you need to 
understand the scope of calculations made by Personal Golf Tracker. PGT provides three different ways 
to look at averages:

1. Your average performance on a single course.
2. Your average on each course - ranked the way you choose.
3. Your average across all courses on which you have entered rounds.

Your average on a single course is shown on the bottom display panel. The calculations presented on 
the panel are always calculated against the Selected golfer on the Selected course. Because many 
golfers play more than one course, it is desirable to rank your performance on each course in such a 
way that you can compare your performance on each course. Since there can be many golfers entered 
into the database, you may want to compare golfers to each other. Such a feature is useful for ranking 
golfers for league play and for families with more than one golfer. PGT provides all of these capabilities.

As mentioned above, the lower panel shows performance for the Selected golfer on the Selected course.

By clicking on List course averages under the Course menu you can rank your performance on each 
course you play. You will notice that the calculations on the Selected course match the calculations on 
the same course when they are ranked.

By clicking on List golfers under the File menu you can rank the golfers in the database. In this case, all 
courses played are used in the calculations.

Note: Unless you are aware of the scope, you can be confused because the averages for the 
Selected golfer and the same golfer listed in the rankings can have different results. Also 
keep in mind that your averages for front, back and eighteen hole rounds can be listed as 
differentials or averages. If you display your performance using averages you can be misled 
because courses you play may not have the same par, such as with par three courses.



Using Different Fonts when Printing

The Print Font Setup menu selection opens a window which allows you to select the font, and to a lesser 
degree, the point size of information you want to send to the printer. You select the section, character 
type, point size, font, and capital letters, and click on the Assign button. This will assign the selected 
character type for the part of the printout selected. You can confirm the assigned character type in the 
status display in the lower, center of the window. Also, the character type will be displayed in the type you 
selected in the center of the window. Keep in mind that you have to click the Assign button to store your 
font selection for each type of character formating. This would be four clicks of the Assign button to 
handle all four sections of the printout.

PGT has been purposely setup so that listings can be printed on standard 8.5 by 11 inch paper in the 
vertical (portrait) orientation. Since many fonts have different character widths, selecting a wide font in a 
large point size and assigning it to the Numbers or Text/Notes style may cause the numbers to run 
together or not fit within the page boarders. The best advice is to experiment with different typefaces and 
sizes to get an understanding of what works and what doesn't.

There may be times when the point size you select may not be available. An example of this is if you 
select the Courier typeface and eight point type. Since Courier is not available as standard in eight point 
type, Windows substitutes its closest font and size that is available. This can cause problems in the 
graphs which use eight point type of the character format assigned to the Text/Notes style.

Another problem that can occur is in the sample display in the center of the window. The font name listing 
shows fonts that are available on the printer. Some of these fonts may not be available as screen fonts. If 
that happens, Windows substitutes the closest font and size that is available for screen display. PGT will 
not warn you of these problems. With the introduction of Windows 3.1 and True Type fonts, both screen 
and printer fonts are resident and these problems seldom occur.

Types of Character Formats

Title: This is the character format you assign to the top of each page which includes the 
program name and the print date. Selecting a decorative font in all caps with bold and 
italic letters with a point size of 12 makes a pleasing appearance.

Heading: This character format prints when a heading is required to clarify the meaning of a 
printout such as the golfer name, course name or graph name. Selecting the same font 
as the title with a slightly smaller point size works well for the heading.

Numbers: This character format is used for all main listings such as golf rounds and summaries. 
Usually a standard Serif or Sans Serif font of eight or ten points works well here.

Text/Notes: This character format is used to print the notes you have assigned to rounds, golfers, and
courses. It is also the font used for the graphs. Note that PGT uses eight point type on 
the graphs regardless of your size selection. The point size you choose is valid for all 
other information, however.



Using the Points Feature

You can enter/assign points to each round as it is entered. What the points mean and how you assign 
them is totally up to you. One possible use are for leagues. For example: You may have a nine hole 
league of two person teams. You could add the golfers into the database as a team name such as John 
and Linda and assign points the their rounds based on those earned during a match. By printing out the 
golfer rankings, you can show the rankings sorted the way you want. Select the sort order by selecting 
"Sort golfers by..." under the File menu.



Using Shortcut Keys

Personal Golf Tracker has a host of key combinations you can use to speed up access to the program's 
functions. Below is a listing of the keys and their actions:

F1 Invoke help for PGT. You will get help on the item you're interested in.
Ctrl+C Add a neew course to the PGT database
Ctrl+D Delete a round from the PGT database
Ctrl+G Add a new golfer to the PGT database
Ctrl+H Change the handicap calculation settings
Ctrl+Ins Copy graphs or text to the Clipboard
Ctrl+L List rounds for the Selected golfer on the Selected course
Ctrl+M Modify the round selected in the rounds listing
Ctrl+N Change the statistics names used with Personal Golf Tracker
Ctrl+P Print reports on the Windows default printer
Ctrl+S Recalculate the rounds and display the summary information
Ctrl+V View the notes assigned to the round selected in the rounds listing
Alt+F4 End Personal Golf Tracker




